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1.0 INTRODUCTION  

 
Starlog Version 4.0 (Starlog V4) is a software package designed for the management of 
Unidata dataloggers. Starlog V4 software is specially designed to manage a data logging 
scheme and data unloads. 

              It is intended to be installed onto a computer where you may use it to create new 
              schemes, load, unload and process data and test logger operation. 

 
The software has a Windows style, complete with drop down and pop menus and help 
messages, as well as easy access to Unidata’s extensive support documentation. 
 
The easy-to-use menus are especially helpful in setting up your data logging project. You 
use the Scheme Editor to define what kind of data to collect and how and when it will be 
logged. Then, using the Navigator Control bar, you can load the scheme into the logger. 
 
Once data has been acquired by and stored in the logger, you can use the Starlog V4 
software to unload it again using the Navigator Control bar. Logged data is transferred to 
your computer in Comma Separated Value (CSV) file format. This format allows easy 
importing of your data into 3rd Party data management and manipulation software such as 
Hydstra, Tideda and Magpie. 
 
To check logger operation, the software includes a test mode. In test mode the logger 
displays data as it is acquired. It also displays the logger status and other important 
information. 

 

Features: 

- Powerful scheme creation system 
- Comprehensive instrument library and editor 
- Multiple user profiles: basic, technical, system developer 
- Multi-buffer support 
- Telemetry support 
- Backward compatibility with Starlog version 3 schemes 
- Fully Windows XP and up compliant 
- Unloads data and converts automatically to a CSV (Comma Separated Value) file for 

easy data manipulation and viewing in Excel, Hydstra, or Magpie 
- View unloaded data in a graphical and textual format with the internal data viewer 
- View real-time readings from the logger in a graphical or textual format 
- Connect to remote sites via a cellular or satellite modem  
- Manage multiple sites from a single PC. 
- Configure basic parameters of the logger scheme. 
 

Note that at present Starlog V4 is unable to: 

- Receive alarms from loggers. 
- Program/unload to/from PCMCIA memory cards. 
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1.1 System Requirements 

- Pentium Processor 233MHz 
- 64MB RAM 
- 32MB hard drive space 
- Windows XP or up 
- SVGA monitor 
- Mouse 
- RS232 serial port 

 
 
 

1.2 The Starlog Data Logging Advantage 

Starlog was specifically designed to log data in remote locations. Remote locations can be 
geographically remote or just an inconvenient distance from common amenities and 
services. 

Starlog’s advantages in geographically remote locations can be seen when considering a 
task like monitoring weather conditions in some remote location in Siberia. You could 
install a Starlog Datalogger in a weatherproof enclosure and connect temperature, 
humidity, and wind speed and direction sensors. Once installed you can retrieve acquired 
data using satellite or cellular telemetry, making the need for site visits exceedingly rare. 

Data logging is a valuable tool for researchers, resource managers and industry. 

Applications include: 

- Water Resource management 
- Environmental Protection 
- Agricultural Studies 
- Alternative energy research 
- Salinity Control 
- Drainage and Storm Water Monitoring 
- Forestry Management 
- Ground Water Research 
- Resource Development 
- Meteorology 
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1.3 What Is This Software Package For? 

Unidata loggers can be described as small computers with specialized I/O (Inputs and 
Outputs). Just as your desktop PC is not much use without an Operating System, or 
applications (Microsoft Office or Adobe Acrobat) a Unidata data logger is not much use 
without a running program or project. We refer to this program as a scheme. 

When you have selected the hardware for the data logging system, five steps are required 
by the user for its operation. 
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1.4 What Is A Scheme? 

 
Using Starlog data logging systems, a data logging project is called a scheme. Elements 
of a scheme are grouped into the following categories: 

- General Details 
      - Scheme title used for reports, printouts 
 

-     Hardware Details 
         - The Unidata data logger being used 
         - What extensions to the logger (if any) are used, for example, relay modules,   
            input modules, output modules, etc. 
 

- Communications Settings 
      - Logger to computer communications port and speed. 

         - Modem setup strings and phone number 
 

- Program Details 
         - Program type (event-triggered?) 
         - How to store data (linear or circular buffer) 
         - Scan rate 
         - When to log 
 

- Log Buffer details 
         - Average, minimum, maximum, total or raw data 
         - The channels to log 
 

- Instruments  
      - Instruments connected, channels used, input scaling 

 
- Events 

         - Definition of events to trigger an output pulse or to log 
 

A scheme combines these elements to generate a working program to operate the logger.   
The program instructs the logger, for instance, to “log the average hourly temperature 
measured by a thermistor probe connected to analogue channel 1. 
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2.0 INSTALLATION 

 

2.1 Starting from CD-ROM 

Insert the CD-ROM disc into the drive. It should start automatically. If it doesn’t, go to  

Start → Programs/All Programs → Accessories → Windows Explorer.    

Select your CD-ROM drive and double-click on Launcher. 

 

2.2 Starting from Downloaded Files 

There is a 30-day trial version of Starlog V4 available from our web site: 

 

1.   To download the required files, go to the Unidata web site: 
 

http://www.unidata.com.au/products/starlog-dataloggers/datalogger-starlog-v4-software/ 
 

 

 

2. Click on Starlog V4 Software (~19MB download) to download  
            starlog_v4.zip file. 
3. Unzip that file into a temporary folder. 
4. Open the folder and run the Setup file. 
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2.3 Installing the Software 

Having started the installation procedure, you should be seeing the following screen: 

 

                           

 

Follow the prompts to install the software. If you are asked to restart your computer, you 
should do so. 

 

2.4 Using the Software for the First Time 

 

2.4.1 Launching the Software 

To start Starlog V 4, you can double-click on the icon on your desktop or 
alternatively, you could select the program from the start menu: 
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2.4.2 Support Files 

The first time Starlog V4 is run, it needs to install some extra support files and configure 
itself, click Extract to install the support files. 

 

                             

 

2.4.3 Backward Compatibility 

The next dialog lets you configure the Compatibility support for Starlog/Starflow V3 
software: 

 

 

 

The above shows a typical configuration. You may need to change the values to suit the 
configuration of your Starlog/Starflow V3 installation. If you don’t have Starlog V3 
installed, just click Next to continue. 

If you want to change these later, you can edit them by going to  

File → Options → Configure StarlogV4 → Starlog V3.  
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2.4.4 Registration 

The next dialog requires you to enter your User Name and Code Key to register the 
software. If you don’t enter a valid User Name and Code Key then you have 30 days as a 
trial user before you are unable to use Starlog V4.  

You will have the opportunity to enter a valid User Name and Code Key every time you 
restart Starlog V4. 

There is an option to register: 

- All Instruments & Loggers in Starlog 
4 or 

- Starflow Instrument Only 

Do this accordingly based on your 
requirements and licence. 

 

 

 

Assuming what you’ve entered is correct and what option you have enabled, you’ll see the 
following: 

 

                      

 

If you instead see the message Incorrect key or invalid user name entered, click OK then 
double-check the values you’ve entered. If you continue to have problems, contact your 
software vendor. 

The next screen confirms your User Name and Code Key. Click Finish to complete the 
setup and enter the main software screen. 
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2.4.5 Un-installation 

If you decided to uninstall StarlogV4 you can do so via the Windows Uninstall or change 
program feature.  

 

 

 

 

Proceed with the Remove option and you will be asked if prompted with the dialog: 

 

 

 

Warning! If you select Yes all scheme files will be purged from the system along with the 
whole StarlogV4 directory and it will not be recoverable. If no is selected these things will 
be preserved. 
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3.0 GENERAL INFORMATION 

3.1 Starting the Software 

To start Starlog V4, you can double-click on the icon on your desktop. 

Alternatively, you could select the program from the start menu: 

 

     

 

Starlog V4 has the following program structure: 
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The most common logger operations are simple to start from the main Starlog window.   
The main Starlog V4 window and major functional areas are shown below: 

 

 

 

- Quickstart Bar: This is the toolbar of icons down the left side. It can be toggled off/on 
by selecting Show Quickstart Bar from the Window menu. 
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Quickstart bar contains:  
 

1. Scheme Control Icons: These provide access to scheme-related functionality, 
such as selecting a scheme, editing a scheme, and viewing data logged by the 
scheme. 

2. Communications Diagnostics Tools: These provide access to tools useful for 
troubleshooting communications problems. Click on the Diagnostics button to 
show them 

3. Launch Bar: This is where you can add groups of external applications. Such 
applications might include custom data analysis tools you may have. When you 
add your first external application, the “Launch” button will be replaced with a 
button labelled with the name of your nominated group. As you add applications 
with different group names, buttons for each group will be added to the bottom of 
the bar. 

 
 

- Communications Status Area: This will read Connected when you are connected to 
a logger, and Disconnected (or blank) when you are not connected to a logger. 
 

- Scheme Name Area: This shows the name of the currently selected scheme. 
 

- Communications Settings: When connected to a logger, this shows the used 
communication settings. For example: COM1:9600,N,8,1, which indicates that COM1 
is the port used, the baud rate is 9600, N means no parity, 8 is the number of data 
bits, and 1 is the number of stop bits. 

 
 

3.2 Options 

Go to the File menu and select Options, then Configure StarlogV4. 
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3.2.1 General Options 

The Schemes Path is where your scheme program files will be saved. These are the 
scheme program definition files and not your logged data. 

 

 

 

Preferred Units is where you select your preferred general type of engineering units. 

Tick Load last used scheme on Startup if you want the same scheme you were working 
with when you last exited Starlog to be automatically loaded when you next run Starlog.   
If this setting is not ticked and Enable Embedded Schemes is, Starlog V4 will attempt to 
use a scheme that has been embedded within the data logger. If there is no embedded 
scheme or embedded support has been disabled, Starlog V4 will read the scheme name 
from the logger and attempt to load the scheme with that name. 
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The Enable Embedded Schemes checkbox controls Starlog attempts to use any 
embedded scheme data. If support is disabled, Starlog will not even look for embedded 
data. Any embedded data that may exist will be ignored. 

Generate Neon Upload File controls if Starlog will create a .neon file ready for uploading 
to the Neon system.  A .neon file is actually a Zip archive that contains a selection of 
scheme files so that they can be uploaded in one action. 

The Auto-resize log buffer columns checkbox toggles the automatic resizing of the 
columns of logged data in the test display. Normally, the columns are re-sized every time 
the display updates (i.e. every scan) which results in considerable flicker. Turning this 
option off will greatly reduce flicker, but may result in columns sometimes not being wide 
enough to fit the data which will require manual adjustment. Changes to this option will not 
affect already opened Test Mode windows; only subsequently opened windows will be 
affected. 
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3.2.2 Data Options 

 

 

 

The V4 Root Data Path setting is already set to a suitable default and should not be 
adjusted. However, if you need to save your unloaded scheme data to a different location, 
you can set that location here. The V4 Data Path Options are a set of checkboxes that 
customise the generated data folder names. Changing them will update the example 
scheme name so can immediately see what effect each checkbox has. 

The Backup Data Path is used by the Unloader function to store duplicate copies of any 
unloaded data. 

Output File Headers controls what information is included in the headers for each column 
of data recorded by your log programs. 

If Unload Comment is ticked, then each time you unload a logger, you will be asked to 
enter a comment.  
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                        In the following sample file: 

       test -  

       S/N: 7434 

       SITEID:ABC123 

       COMMENT:Test comment 

       Time, Voltage(RAW), Voltage(RAW), Temperature(RAW), Humidity(RAW) 

       , mV, mV, degC, pct 

       04/10/2006 15:59:50, 1051.0, 896.0, 26.4, 96.1 

 

test is the scheme name, S/N: 7434 is the logger serial number, SITEID:ABC123 is the 
site ID, COMMENT:Test comment is the comment that was entered at the time the data 
was unloaded, Time, Voltage(RAW), Temperature(RAW), and Humidity(RAW) are the 
Channel Labels (which also incorporates the type of logging), and mV, degC, and pct are 
the Channel Units. 

The remaining lines are the logged data. 

The Data file naming convention field allows you to control how Starlog V4 names your 
unload files. Unload file names must always end with a “.CSV” extension, but the entire 
preceding portion of the filename can be customised. 

The default naming convention is “[SCHEME]_[INDEX]”, where [SCHEME] and [INDEX] 
are variables.  Variables are replaced with their value when the unload file is created.  
Click on Insert Variable to see a list of the available variables: 
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     Variable           Description 
[SCHEME] The name of the scheme 
[SERIALNUMBER] The serial number of the logger 

[DATE:format] 

The date when the unload took place, in the specified format.  yyyy is 
replaced with the year (eg 2017), mm is replaced with the month (eg 
02), and dd is replaced with the day of month (eg 01).   Inserting the 
variable [DATE:yyyymmdd] would be replaced with something like 
20170201. 

[INDEX] A number one greater than the current largest unload index number 
[BUFF] The number of the buffer being unloaded 
[SITEID] The ID of the site 

 

The date format may be edited after it has been inserted into the naming convention field.   
Supported data formatting codes include: 

 

Format Description 

c 
Combined date and time, separated by a space. The date is formatted as per the Short Date 
format in the Windows Control Panel Regional Settings. The time is formatted as specified in 
the Windows Control Panel Regional Settings 

d One to two digit day of month (1-31) 

dd Two digit day of month (01-31) 

ddd Short day of week (Sun, Mon, …, Sat) 

dddd Long day of week (Sunday, Monday, …, Saturday) 

ddddd Date formatted as per the Short Date format in the Windows Control Panel Regional Settings

dddddd Date formatted as per the Long Date format in the Windows Control Panel Regional Settings 

h One or two digit hour (0-23) 

hh Two digit hour (00-23) 

m One or two digit month (1-12) or minute (0-59). Which value is used is determined by the 
context of nearby formats 

mm 
Two digit month (01-12) or minute (00-59). Which value is used is determined by the context 
of nearby formats 

mmm Short month name (Jan, Feb, …, Dec) 

mmmm Long month name (January, February, …, December) 

n One or two digit minute (0-59) 

nn Two digit minute (00-59) 

q Single digit quarter of the year (Jan-Mar=1, Apr-Jun=2, Jul-Sep=3, Oct-Dec=4) 

s One or two digit second (0-59) 

ss Two digit second (00-59) 

w Single digit day of week (Sunday=1, …, Saturday=7) 

ww Two digit week of year (01-53) 

y Day of the year, one to three digits (1-366) 

   yy    Two digit year (00-99) 

   yyyy Four digit year 
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3.2.3 Communications Mapping 

The Communications Map is where you create and name your required communications 
interfaces.   For example, you might have one communication interface for when you 
connect directly via a serial cable to a local data logger, and a second communication 
interface (possibly on the same physical serial port as your cable) for when you use a 
modem to connect to a remote data logger. 

You will need to ensure your Communications Maps are correctly configured before you 
attempt to program or unload a data logger. 

The Communications Map is accessed from the main Starlog V4 window via the menus 
File → Options → Communications Map. 

 

 

 

By default all your physical serial ports will be listed, plus a Network port. The default 
serial ports are all “direct”. To support modem communication, click the New button and 
select Phone modem (RS232) from the list: 

 

 

 

Click OK.  A new communication map for a modem will be added to your list: 
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You will now need to configure it to use the correct serial port (RS232 Communications 
Port), preferred baud rate, and any special dialling prefix numbers to get an outside line if 
you’re on a PABX. 

Note that you do not configure any telephone numbers in this dialog. You will select the 
required Communications Device and set the telephone number when creating/editing a 
scheme via the Settings dialog in the Scheme Editor.   

 

3.2.4 User Profiles 

User profiles are used to simplify the operation of Starlog V4 by limiting the number of 
visible options. If you are the only person using the software, you may wish to ensure the 
full functionality of the software is available. 

User Profiles can be adjusted from both 

-  the main Starlog window File → Options→ Set Access and  
-  the Scheme Editor File → Setup → Set Access 

However you get to it, the following dialog will appear: 
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Starlog V4 starts in the DEFAULT profile, which only allows access to a subset of Scheme 
Editor functionality. The ADMINISTRATOR profile has complete access to all aspects of 
the Scheme Editor and the various libraries, including data logger definitions and the raw 
code generated by the Scheme Editor. The LOCKDOWN profile is more restrictive than 
the DEFAULT profile, allowing only simple scheme changes. 

Select which profile to use via the Set Current Profile drop-down list box. 

If none of the built-in options match your preferences you can create your own named 
profiles with the exact settings required.  Click Add Profile, and then enter the name of 
your new profile.  A new default profile will be added to the list. Select it, and then adjust 
the available features as required. 

To remove a profile you don’t want, select it, and then click Delete Profile. 

Once you have made your selection, it is possible to lock the configuration so it cannot be 
changed. This is useful for when you are setting up a “turnkey” type system where 
unrestricted use of the Scheme Editor may be inappropriate. 

 

To lock the User Profile, click the Lock button. 

 

 

 

You will need to enter your password twice to make sure you’ve got it right. The Lock 
button will change to Unlock. If you need to change the User Profile settings in the future, 
click the Unlock button, enter your password, and make your changes. 
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3.3 Launch Programs Toolbar 

The Launch Programs Toolbar allows you to setup icons to run external applications.   
Icons are put into named groups. 

Click on the Launch button at the bottom of the main tool bar. If you’ve added any 
applications you will see one or more buttons with your nominated group names. Click on 
one of those instead. 

Click on the New Shortcut icon. A small 
window will appear that lists all the 
applications you have added. It will be 
empty if you haven’t added any. 

There are three buttons down the right 
side of the window. If there are no 
applications in the list, the bottom two 
(Edit Program and Delete Program) will be 
greyed out. 

 

 

 

Click on Add Program. Fill in the fields as required, and then click OK. An example is 
shown below: 
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- Program Group specifies the toolbar group into which the shortcut will be placed.    
- Program Name is the title that will appear under the program icon in the toolbar.  
- Protected checkbox in combination with the User Profile option “Enable protected 

shortcut buttons” controls whether or not the shortcut will be visible. 
- Program Path is the full pathname of the application executable file.  
- Command Line field supports special Keyword/Placeholder variables.  

 
Click Insert Keyword to select the keyword/placeholder you want from a list: 
 

 

 

Double-click on the item to insert it into the Command Line field. 

Once an application has been added, the Edit Program and Delete Program buttons 
become active. Clicking Edit Program takes you to a dialog the same as for Add Program.   
Clicking Delete Program will immediately delete the selected application. 

 

 

 

3.4 Arranging Windows 

All open windows within the Starlog application may be arranged by selecting the Tile or 
Cascade options from the Window menu. 
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3.5 Finding the Version of the Software 

To find out what version of Starlog V4 you have, select About StarlogV4 from the Window 
menu. A window similar to the following will appear: 

 

 

 

The version number is shown at the top right (“04.01.0014”). When requesting technical 
support in relation to the software or your schemes, always mention the version of your 
software. 
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3.6 Manually Connecting to a Logger 

Although you would typically configure the logger communications in the scheme, it is also 
possible to manually connect to a logger. 

On the main StarlogV4 window, click either the Connection icon in the 
StarlogV4 group or select Connection from the Logger menu. 

The following window will appear: 

 

 

 

Select the COM port to connect to using the drop-down list.  Click Connect to connect to 
that port. You may then process to program, unload, or test the logger. 

When connected, the Connect button will change into a Disconnect button. Click that 
button to disconnect from the logger. 

There is also a More>> button. Click that to display statistics related to the connection (as 
shown above). When clicked, it will change into a >>Less button. Click that to hide the 
statistics. 
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4.0 SCHEME MANAGEMENT 

 

4.1 Selecting a Scheme 

To select a scheme, click on Select Scheme from the File menu, or click the 
Select icon (shown to the right).  The following window will appear: 

 

 

 

The tabs at the top allow you to view all your V4 schemes, all your V3 schemes (if you 
have any), or to select the scheme embedded into logger (the logger must have been 
programmed with the “SCHEME” instrument).  Select a scheme by double-clicking its 
name. 
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4.2 Creating / Editing a Scheme 

The Scheme Editor is used to create, edit and delete schemes.   It can also create 
templates and data logging systems. The program structure is shown below: 

 

- Scheme section is mainly used for creating and editing schemes with standard 
functionality. 

- Library section is used for modifying the available libraries. Organisations with 
standard logging systems can create templates to suit those systems. There is 
essentially no limit to the systems that can be built. 

- Code section is for those schemes with extended functionality that require custom 
code. It contains a Code editor with tools that assist layout and increase readability. 

 

To create a scheme, you need to open the Scheme Editor. Click on 
Scheme Editor from the File menu, or click on the Scheme Editor icon in 
the main window. 

 

NOTE: V4 software cannot edit V3 schemes.    

You must keep a copy of V3 software installed if you want to edit your old schemes. If you 
select a V3 scheme, Starlog V4 will automatically launch the V3 scheme editor to edit the 
scheme. You can also manually launch the V3 scheme editor by clicking V3 Scheme Editor 
from the File menu. 
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When the Scheme Editor is open, select New Scheme from the File menu, or click the 
New icon on either of the toolbars: 

 

    

 

A list of data loggers will appear. Select the data logger you will be using by double-
clicking on it. For example, a “6004-2” is selected below: 

 

 

 

Three new icons will appear inside the left toolbar: Settings, Instruments, and Log Buffer. 
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4.2.1 Settings 

These are settings for controlling basic logger functionality. 

Click on the Settings icon: 

 

 

 

One of the most important settings is the Scan Rate. This defines how often the logger 
scans (samples) its inputs. Faster scan rates make it more likely the data logger will 
capture accurate minima and maxima, but will shorten the battery life. The scan rate also 
influences averaging.  If you want to log average data every 15 minutes, then a 5 second 
scan rate implies 15×60÷5=180 samples. If you don’t need that many samples, you could 
increase the scan rate to maximize battery life. 
 
Another limit the scan rate imposes is on the maximum logging interval. The maximum log 
interval is 65535 times the scan rate. For example, if you set the scan rate to 1 second, 
the maximum logging interval is 65535 seconds, or 18 hours 12 minutes 15 seconds. If 
you want a log interval of 1 day, you would need a scan rate of at least 2 seconds. 
 

              The Scheme Description should be set to something that will assist you in remember  
              what the scheme is for. 

 
Apart from the Scan Rate, the Communication settings are the next most critical. If they’re 
wrong, you won’t be able to program or unload your logger! You should have configured 
your communications settings earlier under Communications Mapping. 
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The Telemetry Switch field lets you enter the code to select the logger if you have a 
telemetry switch installed.  You must include the “Q” in the field, for example, “Q01”. 
 
The Advanced button allows you to directly edit various communications settings.   
Double-click on the Value fields to edit them. 
 

 
 
For detailed information on each of the settings, see Appendix A – Communications 
Variables on page 83. 
 

4.2.2 Instruments 
 

The Instruments window lets you define what instruments are connected to the logger.   
Instruments define the relationship between what the logger measures (voltages, 
pulses/counts, digital data) and what the instrument measures (temperature, depth, wind 
speed, etc). 
 
Click on the Instruments icon (shown to the right): 
 

 
 
The Instrument Library lets you select from major groups of instruments.    
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Starlog V4 Software comes with the following predefined groups: 
 
- Loggers – Unidata logger instruments 
- PDLTRANS – Unidata Instrument Library 
- NIWA – NIWA Instrument Library 
 

It is possible for you to create custom instruments and libraries to keep them in. 
When you select an Instrument Library, all the instruments in the library relevant to the 
selected logger are shown. 
 
The right half of the Instruments window shows the instruments that have been added to 
your scheme. 
 

4.2.2.1 Adding an Instrument 

To add an instrument to your scheme, either double-click on its line in the left half of the 
window, or select it then click the Add button at the bottom of the window. A copy of the 
instrument will be added to the list in the right half of the window. 

For example, to add the SMS instrument to your scheme: 

 

1. Edit the scheme and select the Instruments icon. 
2. Select the PDLTRANS library. 
3. Select the SMS instrument in the list. 
4. Click the Add button to add the instrument to the scheme. 
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4.2.2.2 Removing an Instrument 

To remove an instrument from your scheme, select it from the list in the right half of the 
instrument window and click the Del button at the bottom of the window, or right-click on it 
and select Delete from the menu. 

 

4.2.2.3 Configuring an Instrument 

To configure an instrument, double-click on its line in the right half of the window, or right-
click on it and select Edit from the menu. Different instruments have different configuration 
windows and options. 

 

4.2.3 Configuring the Logger 

Data loggers are configured just as if they were a regular instrument. When you create a 
scheme, an instrument for the selected logger is always added as the first instrument.   
Double-click on it. For Starloggers, the following window will appear. Other loggers will be 
similar: 

 

 

 
The various tabs show the options available. If you want internal logger channels to be 
available for logging (e.g. the temperature sensor), you will need to make sure their 
entries on the Internal Channels tab are ticked. 

 

4.2.3.1 Configuring the Logger as an SDI-12 Sensor 

When the logger is an SDI-12 sensor, other SDI-12 recorders can access and log data 
sensed by it. This can be useful if you have something with a limited number of inputs, 
such as a Starflow, but would prefer to have all data at a site logged by a single logger.   
You could configure the Starflow as an SDI-12 sensor, and use a Starlogger as an SDI-12  
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recorder to log the depth/velocity/flow from the Starflow, as well as whatever other 
instruments you have (eg wind speed/direction, air temperature, rainfall). 

To set a logger up as an SDI-12 sensor, first add any required instruments to the logger.   
Then open the logger instrument and select the SDI-12 tab. Tick Enable SDI-12 Sensor 
Mode to enable the controls. Next, select the SDI-12 Address to assign to the logger.   
Finally, for each channel you want to make available as an SDI-12 reading, click the Add 
button to add it. The following window will appear allowing you to select from the available 
channels: 
 

 
 
Double-click on a channel to add it to the list. Each added channel becomes an SDI-12 
value, numbered from zero starting at the top.  
The following shows “Battery” as parameter 0 and “Internal Temp” as parameter 1 

 
 

4.2.3.2 Configuring the Logger RS232/UPS 

Open the logger instrument and select the RS232/UPS tab. 

The RS232 Timeout controls how long the logger will remain powered on and ready to 
communicate at each scan interval.   The factory default for most loggers is 1 second, 
which is adequate for direct serial cable connections. However, if communications is to 
take place via a modem, then this should be extended to 3-5 seconds (or more, as 
required). Longer timeouts will lead to increased power consumption while the logger is 
communicating. 

The Scan Synchronous Communications checkbox fine-tunes when the logger checks for 
a computer attempting to communicate with it.   When this checkbox is ticked, the logger 
will wait until the end of a scan before checking to see if there is a computer wanting to 
communicate with it. When this checkbox is not ticked, the logger does not wait.  

After this first check, the logger will only check that the computer is still connected at the 
end of each scan, regardless of the setting of this checkbox. For quick scan rates, this 
setting does not do much, however, for slower scan rates, clearing this checkbox (to 
select asynchronous communication) may improve the logger’s responsiveness to 
communications. 
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The Programmable UPS checkbox controls whether or not the scheme is allowed to 
program the UPS (User Power Supply). This functionality is currently only available using 
custom scheme instructions. 

 

The UPS Prescan (ms) setting control how long the UPS is switched on before the usual 
scan processing is started, such the reading of the inputs. Some instruments powered 
from the UPS may need more time to start than the factory default of 15ms allows. This 
setting allows the prescan delay to be extended as necessary for those instruments to 
work correctly. 

 

4.3 Log Buffer 

Open the Log Buffer window by clicking on the icon shown to the right: 

The Log Buffer window is shown below: 

 

 

 

The Log Buffer window is where you set up the logger memory for recording data by 
selecting what to log and how often to log it. 

Data loggers have one Main Buffer and multiple Event Buffers. Event Buffers tend to be 
small and are used to store data logged on an ad-hoc basis. Whatever memory is not 
allocated to Event Buffers is allocated to the Main Buffer. Since Event Buffers default to 
zero bytes, the default Main Buffer size is all the available memory.   

 

4.3.1 Instrument Channels 

Each Buffer has its own set of the Instrument Channel checkboxes. You control which of 
the available channels gets logged into each buffer. The following channel logging options 
are available; however, some instrument channels may not support all of them (for 
example, temperature cannot be totalised) 
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Option Description 
RAW The instantaneous value of the channel at the time of the log. 

MIN The minimum of the values sampled at each scan over the log interval 

MAX The maximum of the values sampled at each scan over the log interval 

TOT The total of the values sampled at each scan over the log interval 

AVG The average (arithmetic mean) of the values sampled at each scan over the log interval 

avg The average (arithmetic mean) of the values sampled at each scan over the sub interval 

 

In the example screenshot shown above, both the Battery and Internal Temperature 
channels are logging the “AVG” (average of the full log interval). 

As you tick channels to log, or adjust the Log Interval, the software will automatically 
update the Memory Time to show you an estimate for how long the memory will last. The 
estimate does not take into account logging forced by events. 

 

4.3.2 Log Intervals 

The Log Interval is the time between logs. Only the Main Buffer has a Log Interval setting.   
Event Buffers do not have a Log Interval because logging into them is always triggered by 
events. 

At each log, all the Instrument Channels ticked will be recorded into the Log Buffer. 

In the screenshot above, the average internal Battery and Temperature Channels will be 
logged every 15 minutes. 

The maximum log interval is limited by the scan rate. The maximum log interval is 65535 
times the scan rate. For example, if you set the scan rate to 1 second, the maximum 
logging interval is 65535 seconds, or 18 hours 12 minutes 15 seconds. If you want a log 
interval of 1 day, you would need a scan rate of at least 2 seconds. 

 

4.3.3 Sub Intervals 

The Sub Interval setting only relates to the “avg” column of Instrument Channel 
checkboxes (not the “AVG” column, or any other column). Rather than take samples at 
each scan like the “AVG” column, the “avg” column only takes samples during the Sub 
Interval. The Sub Interval is always the time immediately before a Log. Event Buffers do 
not support the Log Interval or Sub Interval settings. 

For example, if the Log Interval is 60 seconds, and the Sub Interval is 20 seconds, for the 
first 40 seconds of the 60 second log cycle only the “MIN”, “MAX”, and “AVG” channels 
will take samples. For the remaining 20 seconds before the log occurs (the Sub Interval), 
all channels (including the “avg” channel) will be taking samples. 
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4.3.4 Buffer Sizes 

Event Buffers must have their size manually allocated. The Main Buffer size cannot – it is 
always allocated whatever memory is left after memory has been allocated to the Event 
Buffers. Click the Set Size button to configure the buffers: 

 

You can adjust the sizes of the Event Buffers in 1KB 
increments by clicking on the small up/down buttons 
to the right of the Event Buffer Size field.   Increasing 
the size of an Event Buffer will decrease the size of 
the Main Buffer by a corresponding amount, and vice 
versa. 

Note that the total capacity of all the buffers will 
always be less than the quoted memory capacity of 
your data logger.   The data logger reserves some 
memory for the scheme program, working variables, 
communications buffers and configuration data. 

 

 

 

4.3.5 Other Buffer Settings 

Settings common to all buffers are: 

- Linear / Circular: When Linear buffers fill up, they stop accepting new logged data.  
When Circular buffers full up, they wrap around to the beginning and start overwriting the 
oldest data. 

- Instrument Channel Ordering: This defaults to Auto Order, however, you can untick the 
checkbox and click on the Set Order button to manually set the logging order of the 
channels: 

 

 

Click on the channel to select it, and 
then click on the up/down buttons on 
the left to nudge it up/down the list. 
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4.4 Events 

Events allow the logger to act on changes on its inputs. Various actions include triggered 
logging, SMS alerts and relay control. A maximum of 32 events are supported. 

 

4.4.1 Types of Events 

There are many different types of events: 

Event Type Description 
None  
Always An event that is always TRUE. 
Channel A > B 

Compares channel A with a fixed value B 
 

NOTE: “<>” is “not equal” (≠). 

Channel A >= B 
Channel A < B 
Channel A <= B 
Channel A = B 
Channel A <> B 
Channel A > Channel B 

Compares a channel A with a second channel B. 
NOTE: There are no “less than” comparisons as “Channel B < Channel A” 
is the same as “Channel A > Channel B”. 

Channel A >= Channel B 
Channel A = Channel B 
Channel A <> Channel B 

Delta Channel A > B 

Monitors channel A and becomes TRUE for one scan when that channel 
has changed by more than B since the last time the event was triggered. If 
channel A has changed by more than B since the event was last true, the 
extra difference is forgotten for determining when the event will next be 
true. If the remainder is important, use the “Every B on Channel A” event. 

Event A AND Event B Becomes TRUE when both event A and event B are TRUE 
Event A OR Event B Becomes TRUE when either or both of event A or event B are TRUE 

Delta Event A 
Becomes TRUE for one scan when event A changes state (from FALSE to 
TRUE, or from TRUE to FALSE) 

Every B on Channel A 

Every scan the absolute difference between the current channel A reading 
and that of the previous scan is added to an accumulator. When that 
accumulator exceeds B, the event is true for that scan and B is subtracted 
from the accumulator. Both rises and falls add to the accumulator, so that a 
rise of 3 units and a fall of 2 would result in an accumulation of 5 units. 

NOT Event A 
Evaluates to the opposite of event A.   If event A is TRUE, this event is 
FALSE, and vice versa. 

On Event A for B Scans 
This event becomes TRUE when event A becomes TRUE, and is held 
TRUE for B scans. 

On Event A Until Event B 
This event becomes TRUE when event A becomes TRUE, and stays TRUE 
until event B becomes TRUE. 

Event A TRUE for B Scans 
This event becomes TRUE for one scan whenever event A has been TRUE 
for B consecutive scans. 

Channel A between B and C 
This event is TRUE whenever channel A is between the values B and C 
inclusive. 

Channel A bit B set This event is TRUE when bit B of channel A is set. 
Channel A bit B not set This event is TRUE when bit B of channel A is not set. 

Channel A High 
(A > B, Reset A < C) 

This is a channel A high event with hysteresis. When Channel A rises 
above the value B, the event becomes true. It will then not become false 
until channel A falls below value C. C must be less than B. 

Channel A Low 
(A < B, Reset A > C) 

This is a channel A low event with hysteresis. When Channel A falls below 
the value B, the event becomes true.  It will then not become false until 
channel A rises above value C.  C must be greater than B. 
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4.4.2 Event Settings 

To edit events, click on the Events icon. The default Basic User Profile is 
configured to hide the Events icon.  You will need to enable it by following the 
instructions under User Profiles. Make sure the Scheme → Events option is 
ticked. The following window will appear: 
 

 
 
Each event has a name, a description, a type, between zero and three parameters, an 
output action, and a force log action: 
 

- Name: While there is no particular length limit, this should be a short mnemonic of the 
event. It is what is shown when another event refers to the event, and in the parameter list 
boxes for those events that take other events as parameters. You don’t see the description 
in those list boxes, so make sure the name will be enough to remember the purpose of 
each event. 

- Description: This can be a longer description of the event. 
- Event: This specifies the type of the event.   See the table under Types of Events above 
- Parameter A: Depending on the type of event this may be a channel or another event. 
- Parameter B: Depending on the type of event this may be a channel, another event, or a 

constant value. 
- Parameter C: So far, only the “Channel A between B and C” uses this parameter (as a 

constant value). 
- Output: This is a list of the possible actions the logger can perform for every scan that the 

event is true. 
- Force Log to Buffer: For every scan the event is true, this will force the selected log buffer 

to log the channels as configured in the Log Buffer window. 
- Logwhile Event: selects which event is used by the scheme to control when data sampling 

and logging is allowed to occur.  When the Logwhile event is true, the logger will take 
instrument samples, eg for averaging, and will log data as programmed. When the Logwhile 
event is false, the logger will still read its inputs, but they will not count towards averages, 
nor will any data be logged. 
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4.4.3 Using Events 

Using events can become complicated because while each event by itself is very simple, 
to get even moderately complex behaviour several events may need to be combined to 
obtain the required functionality. To demonstrate this, the following example describes 
how to implement hysteresis: 

Imagine a logger monitoring temperature and being able to control a cooling system.   
When the temperature exceeds some threshold, the logger should turn the cooling system 
on until the temperature is lowered to some other threshold whereupon it will turn the 
cooling system off.  The two thresholds provide the hysteresis to prevent the fan from 
being rapidly turned on and off.   For this example the upper threshold is 55°C and the 
lower threshold 50°C. 
 
Start by defining the threshold events: 
 

Name Description Event A B 
HT upper High temp on Channel A > B Internal Temp 55 
HT lower High temp off Channel A < B Internal Temp 50 
 
Next are the two events that reflect whether or not the logger is in the high temperature 
state: 
 

Name Description Event A B 
HT High temp state On Event A Until Event B HT upper HT lower 
not HT Not high temp Not Event A HT  

 
The “HT” event is true from the time the logger exceeds the “HT upper” threshold (55°C) 
until the time it falls below the “HT lower” threshold (50°C).  In other words, it’s the 
“temperature is too hot and needs cooling” state. The “not HT” event is true whenever the 
“HT” is not true, i.e. when the system is not “too hot”. 
 
If all you wanted to do was control a cooling system via relays, the above events are all 
you need.   You would attach a latching relay to the logger (such as the 6525 relay control 
module), then add a “switch relay on” output to the “HT” event and a “switch relay off” 
output to the “not HT” event.   There’s no harm in the logger continuously sending “relay 
on/off” commands every scan those events are true. 
 
What if you wanted to send an SMS alarm when the system got too hot?   In that case 
sending multiple messages while the system stayed hot wouldn’t be a good idea.   To only 
send a message when the system flips from “temperature OK” to “too hot” requires a few 
more events: 

 
The “HT change” event detects when the system is flipping between “temperature OK” 
and “too hot”. It detects a change in either direction, but cannot by itself tell which direction 
the system is changing.  To determine the direction a second event is needed. 
 

Name Description Event A B 
HT change High temp state change Delta Event A HT  
HT begin Enter high temp state Event A AND Event B HT HT change 
HT end Leave high temp state Event A AND Event B not HT HT change 
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The “HT begin” event detects when the system is going from “temperature OK” to “too 
hot”.  If the high temperature state has changed (the “HT change” event) AND the system 
is in the high temperature state (the “HT” event) then the system has just changed from 
“temperature OK” to “too hot”. 
 
The “HT end” event is similar to the “HT begin” event, except it detects the change from 
“too hot” to “temperature OK”. It isn’t needed if all you want to do is perform an action on 
the switch from “temperature OK” to “too hot”. 
 

To send an SMS when the system becomes hot, add the “SMS” instrument to the 
scheme, configure the message, then add the corresponding dialout group as the Output 
for the “HT begin” event. 
 

Note that if all you wanted to do was send the message when the system became too hot, 
and didn’t need to worry about when it cooled down, you’d be able to discard the “not HT” 
event, leaving the following five events: “HT upper”, “HT lower”, “HT”, “HT change” and 
“HT begin”. If you DID want to send a “cooled down” message, then you’d leave in the 
“not HT” and “HT end” events, create a second message on the SMS instrument, then set 
the “HT end” output to activate that second dialout group. 
 

To summarize: 
 

Name Description Event A B Output
HT upper High temp on Channel A > B Internal Temp 55  
HT lower High temp off Channel A < B Internal Temp 50  
HT High temp state On Event A Until Event B HT upper HT lower Cooling on 
not HT Not high temp Not Event A HT  Cooling off 
HT change High temp state change Delta Event A HT   
HT begin Enter high temp state Event A AND Event B HT HT change High temp SMS 
HT end Leave high temp state Event A AND Event B not HT HT change OK temp SMS 

 

4.5 Saving the Scheme 

Save your scheme by clicking on the Save icon (shown to the right). 

 

If you’ve saved your scheme before it will immediately save. If you’ve never saved the 
scheme before, the dialog shown below will appear. You can get the same dialog at any 
time by selecting Save Scheme As from the File menu. 

     

 

Enter the scheme name in the File Name field.   
There is a maximum length of eight characters. 

 

The New Group button allows you to create 
sub-folders of schemes.    

Groups may be created inside groups, too. 
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5.0 PROGRAMMING LOGGERS 

Loggers can be divided into two types: Standard Loggers and Neon Loggers. 

 

Standard loggers are programmed directly with Starlog V4 via a serial cable, 
while Neon loggers are programmed through the Neon web interface. 

 

5.1 Standard Loggers 

Standard loggers are programmed from the main screen, by clicking on Program under 
the Logger menu, or by clicking on the Program icon, shown to the right.  You will be 
asked to confirm before the programming will proceed: 

 

 

Clicking OK will open a new window that 
shows the progress of the programming: 

 

 
If all goes well, a Logger successfully re-programmed message will appear (with 
Disconnected as the final message).  Click OK to close the progress window. 

 

5.2 Neon Loggers 

Neon loggers are programmed through the Neon web interface. These include Neon 
Remote Terminals (NRTs), Neon Metering Modules (NMMs) and Neon Remote Loggers 
(NRLs). Starlog V4 must be configured to generate Neon files. See General Options on 
page 15. The “Generate Neon upload file” option must be ticked. 

 

In the Neon web interface, select the Loggers tab of your node, then under the Internal 
Logger tab, select the generated “.neon” file for your scheme. Click the “Upload” button to 
send it to Neon. The screenshot below highlights the important controls: 
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To force the scheme to be loaded 
immediately by the logger, the Starlog 
Configure/Initialise tool should be used. See 
the icon to the right. 

Connect the Neon logger to the computer 
using a serial cable. Click the Retrieve NRT 
Settings button to get the current settings, 
and then click the “Initialise” button to have 
the logger to synchronise with the Neon 
server and start using the scheme loaded 
above. 
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6.0 TEST MODE 

Test Mode is used to check the status of the logger, and to monitor its logging progress. 

 

To enter Test Mode, click on Test Mode under the Logger menu, or click on its 
icon. A window similar to the following will appear: 

 

The Scheme Name shows the name of 
the scheme that has been programmed 
into the logger.  If the scheme in the 
logger isn’t the same as the currently 
selected scheme, the following 
message will be displayed: 

 

 

             You should select the named scheme (in this case “Demo”) and load its Test Display. 
             The entire display may be zoomed by pressing the + (plus) or = (equals) keys.   
             To un-zoom the display, press the – (minus) key.   
             This is also accessible from the Text Size menu item of the Test Mode menu. 
 

The Test Mode window is divided into four sections: 

1. Scheme Information 
2. Log Information 
3. Scheme Channels 
4. Log Buffers 
 

Each of these items is explained in detail below. 
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6.1 Scheme Information 

The Scheme Information section has the 
following items: 

 

 

- Scheme Name: The name of the scheme programmed into the logger. 
- Logger Time: The date/time of the logger. 
- Logger State: One of Primed, Logging, or Stopped: 

- Primed: The logger hasn’t yet started logging. Loggers with no built-in instruments  
                          (excluding internal battery and temperature sensors) will not start logging  
                          until three scans have passed since a plug was connected to their “Input  
                          Signals” connector. 
- Logging: The logging is sampling and recording data. 
- Stopped: The logger is not recording. This may be because the inputs have been  
                            unplugged, or the logger Main Buffer has filled (only applicable to Linear  
                            types). 

- Scan Rate: The time between consecutive samples of the inputs. 
 

6.2 Log Information 

The Log Information section has the following 
items: 

 

 

- Log Rate: This is the time between consecutive logs. 
- Log Size: This is the size of each log entry in the Main Buffer in bytes. 
- First Log: This is the date/time when the first log was recorded. 
- Last Log: This is the date/time when the most recent log was recorded. 
- Memory Expires on: This is the estimated date/time when the Main Buffer will fill up and 

either stops logging (Linear) or starts overwriting the oldest data (Circular).    
How long it will take to reach that date/time is shown in brackets. 

- Memory Usage: This shows how much of the loggers buffers are currently being used. 
 
 
 
 
 
 
 
 
 
 



 

Manual – 6308B Starlog V4 Datalogger Management Software 

 

 
Unidata Manual - 6308B Starlog V4 Software Issue 2.9 14 09 2017.docx Page 46 
 

 
 
 

6.3 Scheme Channels 

 

 

The Scheme Channels display the current readings of the instruments connected to the 
logger.   Double-click on the display field to set the corresponding value on the logger. 

The available channels may be changed via the Edit Channels item of the Test Mode 
menu. Selecting that item will open the following window: 

 

 

Channels defined in the scheme cannot be edited or deleted, but you are able to define 
your own channels.    
Click the Add button to create new channels.    
Clicking the Delete button will delete the selected custom channel.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Manual – 6308B Starlog V4 Datalogger Management Software 

 

 
Unidata Manual - 6308B Starlog V4 Software Issue 2.9 14 09 2017.docx Page 47 
 

 
 
 
The channel parameters are: 
 

- Channel Label: The label of the channel. It is shown in front of the value field. 
- Units: The display units of the channel. It is shown after the value field. 
- Input Data Type: Specifies how the channel data is stored in the logger. One of: 

- Unsigned Byte: One byte. Has the range 0…255 
- Signed Byte: One byte. Has the range -128…127 
- Unsigned Word: Two bytes. Has the range 0…65,535 
- Signed Word: Two bytes. Has the range -32,768…32,767 
- Unsigned Long: Four bytes. Has the range 0…4,294,967,295 
- Signed Long: Four bytes. Has the range -2,147,483,648…2,147,483,647 
- String: Variable number of bytes. The end of the string is marked with a zero byte. 
- Floating point: Single precision floating point. Four bytes.    

Has the range ±3.4×10-38…±3.4×1038 and 7-digit precision.    
Note that Unidata data loggers cannot process floating point data – it cannot be 
totalised or averaged. It is currently supported only for reading SDI-12 sensors. 

- Base Address: 
- Protected(CDT): Indicates that this channel is reading protected logger memory, typically a  

                            configuration setting. 
- Number Bytes: The number of bytes required to store the channel value.    

                           This field is only editable for string Input Data Types; it otherwise   
                           corresponds to the selected Input Data Type. 

- Multiplier: The amount to multiply the logged data before displaying. The Multiplier is  
                  applied before the Offset. The multiplier is independent of any logger bit scaling  
                  for analogue channels the multiplier is applied to the mV reading of the channel. 

- Offset: The amount to add to the logged data before displaying.    
             The Offset is applied after the Multiplier. 

- Formula: Some applications require a formula to transform logged data into a viewable   
                form. 

- Format: The display format of data associated with this channel.    
              Allowed characters are: “#” (hash), “0” (zero) and “.” (decimal point).    
              A “#” will reserve space for a digit (zeroes will be shown as spaces), a “0” will  
              always show a digit in that position. 

 

To save your changes into the scheme files, select the Save option from the File menu.   
Note that when you next save the scheme in the scheme editor, your changes will be lost. 
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6.4 Log Buffers 

 

 

 

The Log Buffers are displayed across the bottom half of the window.    
The Main Buffer plus any Event Buffers are each given their own tab.    
Click on the tab to select the buffer to view. 
 
Each buffer viewer operates in one of two modes: 
 

- Table: This displays the logged data in tabular form. 
- Graph: This display the logged data in a graphical form as a line plot of data.    

             Each logged item forms a series and each can be individually turned on and off. 
 

Select the mode using the Logged Data option under the Test Mode menu. 

 

6.4.1 Log Buffer Table View 

This is the default Log Buffer view.   Each column is a different logged data item.   Each 
row is a log record. 

 

 

 

To change to the Graph view, right-click anywhere over the table data and select Graph 
from the menu. 

To change the number of log records shown, right-click anywhere over the table data and 
select the required number of records from the View sub-menu. The data selected is 
always from the most recently logged records. Since 100 records is the largest number 
available, data logged more than 100 records ago cannot be viewed in Test Mode. You 
will have to unload the logger to see older data. 
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6.4.2 Log Buffer Graph View 

The Graph View displays the logged data in the form of a series line plot. Each logged 
item forms a different series. The time of log is the X-axis, the Y-axis is the value of the 
logged items. 
 

 
 
To change to the Table view, right-click anywhere outside the plot area (either of the axes 
or the Last N records title) and select Table from the menu. 
 
To change the number of log records shown, right-click anywhere outside the plot area 
(either of the axes or the Last N records title) and select the required number of records 
from the View sub-menu. The data selected is always from the most recently logged 
records. Since 100 records is the largest number available, data logged more than 100 
records ago cannot be viewed in Test Mode. You will have to unload the logger to see 
older data. 
 
To adjust which data series are plotted, either use the checkboxes to the right of the plot 
area, or right-click in the plot area and select/deselect the series from the Filter sub-menu. 
 
To see the specific value at a point on the graph, move the mouse over the graph and line 
up the vertical line that moves with the mouse pointer over the point of the graph that 
you’re interested in. After a short delay a popup tooltip will appear showing the date/time 
and value of the data at that position. 
 
The following shows that at 18/11/2008 14:50:00 a value of 8.61 was logged: 
 

 

 

Note that the mouse doesn’t have to be on the plotted line – any position vertically above 
or below, but inside the graph area, will work. 
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6.5 Menu Commands 

When in Test Mode, a new main menu item called Test Mode is made available.   The 
commands are: 

- Correct Time: Programs the logger with a time correction factor that over a period of time 
adjusts the internal logger clock to the correct time.   This correction may take hours or 
even days, depending on the size of the correction and the logger scan rate. 

- Put Value: Allows you to put a specific byte value at a specific address in logger memory. 
- Edit Channels: See Scheme Channels 
- Logged Data: See Log Buffers  
- Text Size: Allows selection of Normal (the default) or High Visibility (large) sized text in the 

test display. 
- Stop Logging: This will stop the logger scheme and put the logger to sleep. The logger 

can only be restarted by re-programming it. 
 
 

7.0 UNLOADING DATA FROM LOGGERS 

Once you’ve had your logger operating for a while, it will have recorded some data.   
Unloading is the action of copying the data stored in the data logger into a file on your PC. 

 

7.1 Unload File Format 

Unload files are CSV (comma separated value) files. CSV files can be directly opened in 
Excel, and are also a common format supported by other software such as Tideda and 
Hydsys. 

 
            NOTE: Version 4 software can only produce CSV files.  
            It cannot generate V3 compatible *.Unn files. 
 

7.2 Automatic Backups 

The unloader supports the creation of backup unload files automatically at the time of 
unload. The backup folder is specified by the Backup Data Path option (see General 
Options on page 15). 

If the backup media is not available at the time of unload, Starlog V4 will display an error 
message and you can either retry the backup, or cancel it. If you cancel it, you will have to 
manually backup the unload file yourself at a later time. 

 

7.3 V4 Data Folders 

Data unloaded for V4 schemes is stored in a buffer sub-folder in a scheme sub-folder of 
the folder specified by the Data Path option. For example, if the Data Path is the default of 
“C:\Program Files\StarlogV4\DATA\”, the scheme name is “TinCreek” and the data was 
logged in the main buffer, then the CSV files will be stored in the folder 
“C:\Program Files\StarlogV4\DATA\TinCreek\Main Buffer\”. 

Backup data is handled similarly. If the backup path is set to “E:\”, backup CSV files for 
the example above would be stored in “E:\TinCreek\Main Buffer\”. 
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7.4 File Naming Convention 

Unload files are named according to the configured file naming convention. By default 
unload filenames include the scheme name and unload index number, but may be 
configured to also include the site ID and date/time.  See Data Options on page 17. 

 

7.5 Unload Procedure 

To unload logged data from your data 
logger to your PC, click on Unload Data 
under the Logger menu, or click on the 
Unload icon. The following window will 
appear: 

 

 

 

 

If your scheme has defined multiple 
buffers, you must unload each one in 
turn.   There are three options for 
downloading each buffer: 

 

 

 

 

- Full Unload: This unloads all the data available on the logger into a new CSV file. 
- Partial Unload: For fixed log interval buffers, this unloads all the data between two  
            dates into a new CSV file.   For event-based buffers, this unloads into a new CSV  
            file a selectable number of log records, starting at the most recent. 
- Incremental Unload: This unloads all data logged since the last time you unloaded 
            the logger. If you’ve never unloaded the logger since you programmed it, this will be  
            a Full Unload. Tick the Append to current file checkbox if you want the data to be  
            appended to the most recently unloaded data, otherwise the data will be stored in a  
            new file. 

 

When you have selected the unload method you want, click the Unload Data button.   
If you have ticked Unload Comment in the StarlogV4 Data Options (see Data Options on 
page 17), then a dialog will pop up asking you to enter a comment: 

 

While data unloads, a window will 
appear showing you the progress of the 
unload: 
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            When the unload completes, several things occur: 
 

- You are asked if you want to save the current log record position for the next 
            incremental unload.  See the Incremental Unload option above. 
- If you have a backup path set a copy of the just unloaded data will be stored under  
            the specified path. 
- The just unloaded data will be added to the list of files: 

 

 
 

You can view a CSV file by double-clicking on it in the list. 
 
 
 

8.0 VIEWING DATA 
 

Starlog is not data processing software.  We recommend that you use Tideda, Hydsys, or 
Magpie to process data. The data viewer is for functional testing only. 
 
To view data that you have previously unloaded, click on Data Viewer under 
the Logger menu, or click the View Data icon. The following window will 
appear: 
 

 

Initially, only the Source Data File tab is available. This is where you select the data you 
want to view. 

 



 

Manual – 6308B Starlog V4 Datalogger Management Software 

 

 
Unidata Manual - 6308B Starlog V4 Software Issue 2.9 14 09 2017.docx Page 53 
 

 

 

8.1 Source Data File 

Before selecting the file to view, you must first select the type of data you want to view.   
There are four supported types: 

 
- StarlogV4 (*.CSV): V4 data files generated by V4 software from V4 schemes. 
- Archive (*.CSV): Arbitrary CSV files. 
- StarlogV3 (*.CSV): V4 data files generated by V4 software from V3 schemes. 
- StarlogV3 (*.Ann): V3 data files generated by V3 software. 
 

        NOTE: V4 cannot directly view V3 unload files. Before you can view V3 data, you must  
        create *.Ann files for each *.Unn file using an ASCII report created in the V3 Report  
        Editor and then displaying that report in V3 to create the file(s). 
 

Selecting the type of data will change the tree of available files in the bottom of the 
window. The first line of the window will show the folder that Starlog V4 is looking in for 
data files. In the sample screenshot above Starlog V4 is looking under  
C:\Program Files\StarlogV4\DATA. 
 

8.1.1 Starlog V4 (*.CSV) Files 
 

These files are grouped by scheme, 
each scheme will have one or more 
buffers, and each buffer will have its 
own set of logged data files. 

 

The following screenshot shows that 
there is a scheme called Demo, which 
has available data from its Main Buffer, 
and the only data file available is a file 
called Demo_01.CSV. 

 

 

8.1.2 Archive (*.CSV) Files 

These are whatever CSV files Starlog V4 can find in the specified folder. CSV files to be 
viewed in the Data Viewer have some formatting requirements: 

- The first line in the file assigns a name to each column consisting of the channel 
          name and the logging method (raw, average, etc). 
- The second line in the file assigns the units to each column (mm, degC, etc). 
- The third line and beyond is the unloaded data. 
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8.1.3 Starlog V3 (*.CSV) Files 
 

These files are all the CSV files, 
grouped by scheme, stored in the 
scheme folders under the folder 
specified by the Starlog V3 Data Path 

 

The following screenshot shows a 
single scheme called SDITEST with a 
single data file called SDITEST_01.CSV

 

 

 

8.1.4 Starlog V3 (*.Ann) Files 
 

These files are all the *.Ann files stored 
in the folder specified by the StarlogV3 
Schemes Path. They are listed in 
alphabetical order, but not grouped by 
scheme. 

 

The following screenshot shows files 
from five different schemes: 

ERAGC2 (4 files),  

ERAGCMBL (1 file),  

ERAJABWA (1 file),  

ERAMAG01 (4 files), 

ERAMAG28 (1 file) 
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8.2 Viewing the Data File 

Once you’ve located the data file you want to view, there are a number of ways to open it: 

- Double-click on it to open it using the Starlog 
V4 built-in Data Viewer (see Opening with the 
Built-In Data Viewer below). 

- Right-click on it to open a context menu: 

The “Open with” options are described below. The 
Send To, Copy, Delete, and Open containing folder 
are all handled exactly the same as when you right-
click on a file in the standard Windows file Explorer. 

Details of how to configure the Send To context menu 
are contained in Appendix B on page 85. 

    

 

8.2.1 Opening with the Built-In Data Viewer 

Opening a data file using the built-in data viewer will open the file in the Graph View.   
There is also a Table View where you can view the data as text. You can freely switch 
between these two modes and the Source Data File mode (see Source Data File on page 
53) by selecting the appropriate tab at the top of the window. 

 

8.2.1.1 Graph View 

The default mode for viewing your data is the Graph View. This shows a zoomable graph 
on the left and graph control buttons on the right. The legend may be moved by dragging 
it to a new position. 
 
The graph is zoomable by clicking and dragging out the rectangular area you want to 
zoom in to. Reset the zoom by right-clicking on the graph. The zoom level is also reset 
when you make a change to the visibility of any channel. When you hover your mouse 
over the graph, the time of log of the data you’re hovering is shown at the bottom left, next 
to the scrollbar. 
 
The example below has the Battery channel turned off, leaving the Internal Temp. It also 
shows the hidden controls that appear when the Channel Filter, Cumulative Totals, and 
Set Y-Axis buttons are pressed: 
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The Channel Filter controls which channels are plotted on the graph. 
 
For each Cumulative Total item that is ticked, a new series is added to the graph that plots 
the cumulative total of the values of the selected channel. 
 
The Set Y-Axis button opens a list of channels titled “Use 2nd Y-Axis”.   Each channel 
ticked is taken into consideration when determining the scaling used for the 2nd Y-Axis that 
runs down the right side of the graph. 
 
The Print button will print the graph. The Save buttons allows the graph to be saved as a 
Windows Bitmap (BMP) file. 
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8.2.1.2 Text View 
The Text View shows your logged data in a tabular form. The column widths are 
adjustable by dragging the divider between them.   Use the scroll bar to select the data to 
view. 
 

 

 

8.2.2 Opening with Notepad 

Opening your data file in Notepad can be useful if you suspect some file corruption.   
Notepad doesn’t try to interpret the data, so you can scan through it and manually correct 
any anomalies. 
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8.2.3 Opening with Excel 

Opening your data in Excel gives you a lot more power to display, format, print, and 
analyse your data. When opened in Excel, two sheets are created; the first one is for 
viewing the data in a tabular format: 

 

 
There is also a second sheet called “filename_Chart” that displays the data as a graph: 
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9.0 DIAGNOSTICS 

Diagnostics are accessed from the main Starlog V4 window by selecting the 
Diagnostics tab on the left toolbar.   See the screenshot to the right: 

 

Diagnostics provides several functions to assist you with various problems you may 
encounter using data loggers.   Each function is explained below. 

 

9.1 Comms Window 

The Comms Window function may be accessed by clicking the Comms Windows 
item under the Logger → Diagnostics menu, or by clicking the icon shown to the 
right.   It allows you to watch the communications between your PC and your 
data logger.   You can watch the progress of logger programming or unloading, or you can 
watch the commands issued during the test display. 
 
The Comms Window is frequently useful for diagnosing modem problems and logger 
baud rate mismatches. 
 

 
 
Data sent from the PC to the logger is shown in green, while data sent from the logger to 
the PC is shown in blue. The above screenshot shows communications that result from a 
typical test display. If no communication was taking place, you’d just expect to see regular 
star (asterisk ‘*’) prompts from the logger. 
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     The top of the window lets you control the serial port, and provides some status indicators: 
 

- Connect/Disconnect: Click to connect/disconnect to/from the selected comms port.                               
- NRT Menu: Provides access to the NRT configuration menu. 
- Diagnostics: This will activate the logger diagnostics mode. 
- SDI-12 Test: This will enter the SDI-12 Test mode.  
- Initialize: This will reinitialise the logger. If the logger is asleep, this will wake it up.  

                 The scheme and logged data are not affected. 
- Reset: This will reset the logger to its default configuration. 
- Edit Address Book: See Address Book on page 61. 
- Direct to COM1: Selects the type of communications port to use.   

 
     Different selections affect what remaining controls are visible: 

 
- Direct to COMx: Physical RS-232 serial comms ports available on the  local PC. 

 Comm Port: The local communications port to use. 
 Baud rate: The baud rate to use. If no star prompts are detected, the 

software will automatically cycle through all the baud rates until a star 
prompt is detected. 

 DTR: Controls the Data Terminal Ready signal. Modems require this signal 
to be on (ticked) to enable dialling out to other modems. 

 RTS: Controls the Request To Send signal. Unidata data loggers require this 
signal to be on (ticked) to wake up for communication. 

 DSR: Indicates the current state of the Data Set Ready signal.    
                      The DSR state usually reflects the DTR signal. 

 CTS: Indicates the current state of the Clear To Send signal.    
                     The CTS state usually reflects the RTS signal. 

 CD: Indicates the current state of the Carrier Detect signal.   
                      Modems turn this signal on when they are connected to another modem. 

 Phone Number: The telephone number to dial when establishing the 
connection. 

- Network (UDP): Virtual communications ports provided over a TCP/IP network. 
 IP Address: The TCP/IP address of the remote communications port. 
 Port: The TCP/IP port number of the remote communications port. 

- Use Address Book: Select a site defined in the Address Book to connect to.    
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9.1.1 Address Book 
The Address Book allows you to manage the connection details for many sites all in one 
place. It allows you to create a single generic scheme, and then connect to many different 
sites to use it. 
 

 
 
Sites can be gathered into groups. Groups may contain other groups. Create groups by 
first selecting either the top-level “Address Book” item or the containing group.    
Then click “Add Group” on the toolbar. 
 
Add sites by selecting the top-level “Address Book” item or the containing group, then 
click “Add Site” on the toolbar. 
 

 
 
Enter the site name, select the communications device and click OK. Suitable default 
parameters for the selected communications device will already have been filled in.    
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Other parameters will need to be set.    
For sites that connect directly to a serial port or modem, the important parameters are: 
 

- RESET: The command string used to initialize the modem.    
            A typical setting would be “ATZ”, the modem initialization command. 
- SETTINGS: The command string used to set any further modem parameters.  
            A typical setting might be “ATE0” to turn off local echo on the modem, which may 
            otherwise interfere with communications. 
- OUTSIDELINE: The number used by the modem to access an outside line through 
            a PABX. May be left blank if using a direct line. 
- PHONENUMBER: The telephone number to dial.    
            May be left blank for direct connections. 
- TELSWITCH: The telemetry switch code to use. May be left blank. 
 

               For sites that connect via a TCP/IP network (UDP), the important parameters are: 
 

- ADDRESS: The TCP/IP address of the remote communications port. 
- PORT: The TCP/IP port number of the remote communications port. 

 
Sites can be renamed by clicking twice on their name in the tree in the left window pane. 
 

9.2 Velocity Trace 
 

The Velocity Trace function may be accessed by clicking the Velocity Trace 
item under the Logger → Diagnostics menu, or by clicking the icon shown to the 
right.   It is only available for schemes built for the Starflow data logger.   
The Velocity Trace allows you to examine to profile of water velocities detected by the 
Starflow. 
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The horizontal axis is the velocity in mm/s, the vertical axis is the number of samples 
detected.   The red line indicates the median velocity, which is the velocity used by the 
Starflow. 
 
The plus/minus magnifying glass buttons adjust the horizontal axis through a number of 
different scales.   For example, the above screenshot shows all the velocity data bunched 
up between 0 and 1000mm/s. The plus button would expand that to show greater detail. 
 

9.3 Upgrade Firmware 
 

The Upgrade Firmware function may be accessed by clicking the Upgrade 
Firmware item under the Logger → Diagnostics menu, or by clicking the icon 
shown to the right.   It allows you to upgrade the internal firmware of most 
Unidata data loggers. 
 
Click the Query Logger button to have the software determine what type of logger is 
currently connected, and what version of firmware it is currently running. The following 
screenshot shows the results of querying a Yellow Memory Card Starlogger: 

 

    
 
 

- Logger Type: Shows the logger type identified by the Query Logger function. 
- Current firmware revision: Shows the firmware version currently programmed in 
            the connected data logger. 
- Available Versions: Lists all the firmware available to the Starlog software that is  
            compatible with the connected data logger. You may click the Browse button to  
            manually select an unlisted firmware, but updating a logger with unlisted firmware  
            may make the logger unusable or even damage it! 
- Query Logger: Automatically identifies the logger connected to the PC. 
- Upgrade Firmware: Click to upgrade the connected data logger to the firmware  
            selected in the Available Versions field. The window will indicate the progress of the  
            upgrade 
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9.4 SDI-12 Test 
 

The SDI-12 Test function may be accessed by clicking the SDI-12 Test item 
under the Logger → Diagnostics menu, or by clicking the icon shown to the right.   
It allows you to check the operation of the data logger as an SDI-12 recorder and the 
operation of any SDI-12 sensors connected to it. You are able to issue identify, 
measurement, and read commands. 
 
When the window is first opened, click Connect to connect to the data logger and start 
SDI-12 diagnostics: 
 

 
 
Next, click Search to send identification requests to the first ten sensors.    
The window will list any sensors found: 
 

 
 
The above screenshot shows that there is a Unidata 6509C Water Level instrument, 
connected on address 0, and no other instruments on any other channel. 
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To send commands to a sensor, select it from the list, then select the command to send 
from the drop-down list (the “Measure (aM!)” in the above screenshot). When you select a 
command, the actually command that will be sent on the SDI-12 bus is shown next to it 
(the “0M!” in the above screenshot). Click Send to send the command on to the SDI-12 
bus. 
 

 
 
If there is a response, it will appear in the communication log area, and the software will 
also provide an interpretation of the response. The above shows the response to a 
Measure command, the following is the response to a subsequent Read: 
 

 
 
Note that different sensors may return not just different values, but different numbers of 
values. Most sensors will only return a single value. 
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9.5 Configure Modem 
 

Configure Modem is used to program a modem with the settings appropriate for 
use either locally (to dial out to remote sites), or remotely (to be dialled into from 
your computer). For example, a remote modem must be configured to auto-
answer. 
 
Click on the icon to run it. The following window will 
appear: 
 
Select the correct Serial Port and Baud rate, then 
click Local to setup the modem for local use (i.e. to 
dial out to remote sites), or click Remote to setup 
the modem for remote use (i.e. to be dialled into).   
A progress bar will fill in across the bottom of the 
window while the modem is identified and 
configured. 
 
 
 

10.0 GENERAL PURPOSE INSTRUMENTS 
 

See also Instruments on page 31 for a general discussion of instrument support and 
management. 
 

10.1 BUTTONS: Configurable Test Mode Buttons 
 

The Test Mode Button instrument lets you add buttons to the scheme test mode display 
that will perform a variety of actions. 
 

10.1.1 Configuration 
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- Button Type: The different button types have different parameters, explained below: 
 
 Set Channel: A button that will ask for a value to set the specified channel/memory 

when clicked. 
 PUT Value: A button that will put a specified value into the set channel/memory 

address when clicked. 
 Toggle Value: A button that will toggle the specified channel/memory between two 

values when it is clicked. 
 

- Protected Button: Protected buttons may be blocked from use via the User Profile option   
                               “Enable/disable locked test mode buttons” setting 
 

- Target: Select either “Target Channel” or “Target Address”: 
 
 Channel: Set the “Target Channel” to the channel to alter. 
 Address: Set the “Target Address” to the address in logger memory to be affected  

                 by the button. Set the “Data Type” to the type of data at the given  
                 address. Set Channel Buttons   
 Button Caption: The text that will appear on the button. PUT Value Buttons 
 Value to PUT to logger: The value sent to the logger when the button is 

pressed. Toggle Value Buttons                 
 

- TRUE Value to send to logger: This is the value sent to the logger when the button state 
becomes “TRUE”. 

- TRUE button caption: The button text shown while the button is in its “TRUE” state. 
- FALSE value to send to logger: This is the value sent to the logger when the button state 

becomes “FALSE”. 
- FALSE button caption: The button text shown while the button is in its “FALSE” state. 

 
 
The example shown in the configuration screenshot shows the settings for a toggle button 
that will restart a data logger logging after it has stopped, and stop the logger if already 
logging.   It is only suitable for use with event logging, where the date/time is logged with 
each item. 
 

                         
 
While the logger is logging, the byte at address 65 has the value of 1. That corresponds to 
the FALSE state, and so the FALSE caption “Pause” is shown.  Pressing the button 
toggles the state of the button to TRUE and Starlog will put the TRUE value (2) into the 
byte at address 65, then update the button to show the TRUE caption “Resume”. 
 
Note that the example configured the TRUE value/caption to be 2/“Resume” and the 
FALSE value/caption to be 1/“Pause”. The opposite configuration (TRUE as 1/“Pause” 
and FALSE as 2/“Resume”) would have worked exactly the same. 
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10.2 CUSTOMACTION: Custom Visual Basic Actions 
 

NOTE: This instrument is intended for use only by Unidata engineers. It is documented 
here for completeness, but technical support cannot be provided for its use. 
 
The custom action instrument allows arbitrary Visual Basic code to be processed in 
response to various V4 tasks.   Each task requires a Sub Main routine be defined.    
The tasks are: 
 

- Before Program: Called after V4 confirms that programming will erase logger memory, but 
before any communications takes place. Requires that Process.Continue be set to True in 
order for the programming to take place. 

- After Program OK: Called after V4 successfully reprograms and disconnects from the 
logger. 

- After Program Error: Called after V4 disconnects from the logger when the logger cannot 
be programmed for some reason. 

- Before Unload: Called before V4 connects to the logger to perform an unload, and before 
the unload comment is requested.   Requires that Process.Continue be set to True in order 
for the unload to take place. 

- After Unload OK: Called after V4 disconnects from the logger when the logger has been 
successfully unloaded.   Requires that Process.Continue be set to True in order for the 
unloaded data to be saved. 

- After Unload Error: Called after V4 disconnects from the logger when the logger cannot be 
unloaded for some reason. 

- Testmode Start: Called after V4 has connected to the logger and successfully read the 
display data. 

- Testmode Stop: Called before V4 disconnects from the logger. Requires that 
Process.Continue be set to True in order to disconnect from the logger and allow the test 
mode window to be closed. 
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10.3 EVENTCNTR: Event Counter 
 

The event counter instrument counts the number of scans a selected event is true.   
              It supports a variety of counter sizes (larger sizes support higher maximum count values),  
              and supports a number of different methods to reset the count, including never. 

 

10.3.1 Requirements 
 

          One event to count. 
 

10.3.2 Configuration 
 
 

 
 

- Event: The event to count. 
- Size: How big a count to support: 

 Byte: One byte, maximum count of 255. 
 Word: Two bytes, maximum count of 65,535. 
 DWord: Four bytes, maximum count of 4,294,967,295. 

- Reset: When to reset the count value to zero. This setting may be overridden via the reset 
event output (see below). 
 Never: The counter will never be reset to zero. 
 After Logging: The counter will be reset to zero after it is logged. 
 On Event: The counter will be reset to zero when the selected event is true. 

 
In addition to the above controls, the event counter instrument creates an event output 
that may be used to reset the counter. It is functionally identical to the “On Event” reset 
option above. 
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10.4 FREQUENCY: Generic Frequency 

The generic frequency instrument lets you read any rate based input from a counter 
channel.   The instrument automatically incorporates the logger scan rate into the channel 
scaling so that the scaler is the conversion factor for degrees to required units. 

   NOTE: The scan rate is incorporated when you click on OK. If you later change the scan 
   rate you will have to re-open the setup window to update this instrument with the new 
   scan rate. 
 

10.4.1 Requirements 

           One counter channel. 
 

10.4.2 Configuration 

 

 

 

- Input Channel: Select the counter channel to measure the sensor on. 
- Label: Enter a label for display in Test Mode and the Data Viewer. 
- Scaler: Enter the conversion factor for Hz to specified units. 
- Units: Enter the units for display in Test Mode and the Data Viewer. 
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10.5 GENPT: Pressure Transducer 

The Generic Pressure Transducer instrument can be used to read a range of analogue 
pressure transducers.   The output will be scaled to read directly in mm based on the 
selected Range and Output. 

 

10.5.1 Requirements 

          One analogue channel. 
 

10.5.2 Configuration 

 

 

 

- Label: Enter a label for channel display in Test Mode and in the Data Viewer. 
- Input Channel: Select the channel to measure the current. 
- Range: Select the range of the sensor. 
- Output: Select the output type of the sensor. 

 

10.6 LOOKUP: Lookup Table 

The Lookup Table instrument lets you solve a complex mathematical function on the 
logger. This could be a non-linear function such as a thermistor, or stage-flow relationship 
over a fixed weir.   Solving these functions on the logger offers advantages to the user 
such as true display of parameters on the Starlogger LCD, easy processing of data on the 
logger e.g. volume accumulation of flow, or easy transfer of true value via SDI-12, Modbus 
etc. 

The Lookup table instrument lets you enter a formula directly and generates a lookup 
table that covers the range selected. The instrument automatically takes into account the 
scaling applied to the source channel. 

A lookup table can use quite a large amount of memory so it’s important to only define the 
lookup table of the required range to minimize memory requirements. 
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10.6.1 Configuration 

 

 

 

- Result Label: Enter the label for display in StarlogV4 Test Mode and Data Viewer. 
- Result Units: Enter the units for display in StarlogV4 Test Mode and Data Viewer. 
- Pre-scale: Enter the amount to pre-multiply the values to be stored in the logger. Since the 

logger can only store integer values, we can “pre-scale” the values by “x” and then divide 
the value again by “x” for display. 
For example, with a pre-scale of 10, a flow of 145.6 would be internally stored as 1456 and 
divided by 10 for display and data unloads. 

- 2-byte: Select 2-byte if the pre-scaled results are all between 0 and 65535 (for example, 
the result 1456 above qualifies). 

- 4-byte: Select 4-byte if any of the pre scaled results are more than 65535. 
- Source Channel: Select the channel to use as the input to the lookup table. 
- Table Range: Enter the range of “Source Channel” where the lookup table is valid. 
- Table Size: Select the number of bytes for the table. A smaller table size will have less 

resolution but will require less logger memory. 
- Result =: Enter the Formula to solve. Reference the Source Channel using its label. 
- Create Table: Click on Create Table to test the formula and generate the lookup table 
- Lookup table window: This is a display of the results of the lookup table process. 

 

10.6.2 Example – Weir Flow 

 
Formula Result Field 

Flow = 125.65h1.8-12.34 

Where “h” is the water height (or Depth) 

125.65*Depth^1.8-12.34 
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10.6.3 Example – Flow Scaling 

Formula Result Field (all on one line) 

Depth is unscaled less than 100, multiplied 
by 1.2 between 100 and 200, and multiplied 
by 1.5 above 200. 

Depth*(Depth>=0)*(Depth<100)+ 
Depth*(Depth>=100)*(Depth<200)*1.2+ 
Depth*(Depth>=200)*-1*1.5 

 

NOTE: Comparison operators evaluate as -1 for “true” and 0 for “false”. The “*-1” in the 
last result line above is to handle the previous condition values. 

 

10.7 MINMAXTIME: Time of minimum/maximum 

This instrument allows the time of a channel minimum/maximum to be logged. The time 
and corresponding minimum/maximum value is reset on every log. 

 

10.7.1 Configuration 

 

 

 

The configuration is simple – select the channel for which you want to capture the 
minimum and maximum, and then click OK. If the instrument for the selected channel has 
an associated picture, that picture will be shown on the left. 
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Next, go to the Log Buffer window: 

 

 

From there you can select what to log.   Note that while you can still select the MIN / MAX 
boxes for the original channel, it is recommended that you log the RAW min/max channels 
of the min/max time instrument, as shown above. 

 

10.8 RELTIME: Relative Time Channels 

 
The Relative Time Channels provide channels for the following: 

- Time of Day (TOD) in HHMM format, e.g. 1030 = 10:30. 
- Minute of Day (MOD) in the number of minutes passed since midnight in the range  
          0…1439. 
- Day of Week (DOW) in the range of 0…6 (0 = Sunday). 
 

10.8.1 Configuration 

                

 

See page 65 for details on the Generic 
Instrument Setup Window. 
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10.9 SCHEME: Embedded Scheme Information 

The embedded scheme information instrument saves some of the scheme definition 
inside the logger program, so that when the logger is programmed, the saved portion of 
the scheme definition is programmed as well. 

 

The saved scheme information can be subsequently used by Version 4 to unload the 
logger or display the test mode without needing the original scheme.   The saved data will 
be read from the logger and used directly. 

 

To use the embedded scheme information, select the “Embedded V4 Scheme” tab when 
selecting a scheme, then the “Direct Connection” item: 

 

 

 

10.10 SCHEME_INFO: Scheme Information Report 

The Scheme Information Report instrument generates a text report of the scheme 
settings, instruments, log buffer, etc.   This report is generated whenever the scheme is 
saved.   To view the report, double click on the instrument.   A window similar to the 
following will appear: 

 

 

 

The report can be re-saved elsewhere, printed, etc. 
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10.11 SDI: SDI Transducer 

 
The SDI transducer instrument lets you read any SDI-12 sensor connected to the data 
logger using the SDI-12 protocol. The SDI instrument lets you configure the scheme to 
read the sensor on the specified address, retrieve the specified parameter set, specify the 
data type to store the reading in, how often the read the sensor, and what channels the 
sensor will return. 
 
If multiple SDI-12 sensors are connected to the logger then multiple SDI instruments can 
be added to the scheme. Each instrument can be individually configured and all the 
sensors will be placed on a queue system. If an instrument requests a read when the SDI 
bus is busy with another instrument then the request will be placed on the queue and 
serviced when the bus is free. All sensors are checked on turn and therefore none will be 
“missed out” if an earlier sensor initiated another read before the previous request was 
serviced. 
 
The SDI instrument will also add an “init SDI-12 read on address a parameter n” output to 
the scheme outputs list. If you use this output, you must select Manual as the Refresh 
Rate. Note that because the logger can only read one sensor at a time you have to ensure 
that sufficient time is allocated to read all sensors 
 

Warning: The settings in the instrument setup window must match the sensor i.e. Sensor 
address, number of channels returned for the instrument to function correctly. Defining 
fewer channels than the sensor actually returns can corrupt other instrument readings on 
the logger. Use the SDI-12 Test 

 mode (described on page 64) to determine how long the sensor will take to return a 
reading, and how many channels it will return. 
 

10.11.1 Requirements 

        6004B, C or D Starlogger, Prologger or Micrologger based data logger. 
 

10.11.2 Configuration 
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- Name: Enter the name of the SDI-12 sensor (for display only). 
- Description: Enter the description of the SDI-12 sensor (for display only). 
- Address: Select the SDI-12 address of the sensor. 
- Parameter: Select the parameter set to return from the sensor. Many sensors can return 

more than one parameter set e.g. main readings in parameter set 0 and diagnostic 
information in parameter set 1. Each parameter set has to be treated as a separate 
instrument.   By default you would generally use parameter set 0.   
This correlates to a SDI-12 measure command of “aM!”. 

- Data Type: Select the data type to use for the stored readings: 
 Integer: Store the values as 2-byte integers.   Integer values are easy to manipulate 

(e.g. calculate average), however, to convert the floating point received by the 
sensor to integer values the logger simply removes the decimal point. 
Therefore “123.45” becomes “12345”. For this reason the response of the sensor 
must have a fixed number of decimal points.   Also the converted value must fit 
within the range -32768 to 32767. Values that fall outside of this range will be 
incorrectly interpreted by the logger. 
You also have to enter a multiplier and format string to revert the converted values 
back to values for display. 
For example, “123.45” will be stored as 12345.   
Therefore the multiplier must be 0.01 and format must be “##0.00”. 

 Floating point: Store the channels as 4 byte floating point values. Note that this will 
work for all instrument types, but you will not be able to manipulate the channels in 
any way (e.g. calculation of averages). 

- Refresh Rate: Select how often to read the sensor.  
 Log Interval: Read the sensor once just before the log scan. 
 Fixed Interval: Read the sensor every “n” seconds. 
 Continuous: Read the sensor as fast as possible. 
 Manual: Manually initiate the SDI-12 via the Scheme Editor Events window. 

- Read Time: This field is only used when the Refresh Rate field (above) is set to Log 
Interval. Enter the amount of time to allow for the sensor to complete its reading. Note that 
since all sensors are read in turn, if you require all of the sensors read in time for the log 
scan then the easiest way is to add the time each sensor requires (rounded up to the 
nearest scan interval) + 1 scan for extra processing time e.g. Sensor 1 takes 14 seconds, 
sensor 2 takes 23 seconds, scan rate is 5 seconds. Sensor 1 would be set a read time of 
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15+5=20 seconds, and sensor 2 would be set a read time of 25+5=30 seconds. The 
software would automatically query Sensor 1 50 seconds before the log, and Sensor 2 20 
seconds later at 30 seconds before the log. 

- Refresh Interval: This field is only used when the Refresh Rate field (above) is set to Fixed 
Interval.   Enter the number of seconds between initiating a read from the sensor. 

- SDI channel tab: Select the channel to edit. 
- Label: Enter a label for channel display in Test Mode and in the Data Viewer. 
- Units: Enter the units for channel display in Test Mode and in the Data Viewer. 
- Multiplier: Enter the multiplier to scale the result by.   When using Integer Data Type refer 

to Data Type (see above) for correct calculation of multiplier. 
- Offset: Enter the offset to scale the result by. 
- Format: Specify the display format.   When using Integer Data Type refer to Data Type for 

the correct format. 
- Add: Click on Add to add a new channel to the instrument.   Note that you must define a 

channel for every parameter the sensor returns whether you need the channel or not. 
- Delete: Click to remove the currently selected channel from the instrument. 

 
 
 

10.12 SDI_DEBUG: SDI Debugger 

The SDI Debugger instrument can be used to monitor the SDI-12 queue system. 
The SDI Queue channel is the bit-mapped representation of the SDI-12 queue. The MSB 
(far LHS) indicates that a read is in progress, and the other bits represent requests for 
data for each SDI-12 instrument in the scheme. The SDI Data channel indicates that new 
data is available for that instrument. 
 

10.12.1 Requirements 
 

           6004B, C or D Starlogger, Prologger or Micrologger data logger. 
 

10.12.2 Configuration 
 

             

See page 65 for details on the Generic 
Instrument Setup Window  
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10.13 SITEID: Site Identifier 
 

The site identifier instrument creates a special data channel that can be programmed with 
an arbitrary text string. The site ID is set after the logger has been programmed.   Open 
the Test Mode display, and then double-click on the “Site ID” field. Enter your site 
identifier and click OK. 
 
The Site ID can be logged like any other data channel on the logger.   It can also be used 
to name unload files.   See Data Options on page 17. 
 

10.13.1 Configuration 
The only configuration option is adjusting the size of the site ID. The size does not include 
a trailing zero that marks the end of the ID, therefore, if you need to be able to enter, for 
example, an eight character identifier, the site ID will take up nine bytes of logger memory. 
 
 

10.14 SMS: SMS Dialout Group Manager 
 

The SMS Dialout Group Manager is used to send SMS messages in response to events. 
The instrument allows an event to be associated with a message and a group of 
telephone numbers. When the event occurs, the message is sent to every number in the 
group Different messages will require a separate dialout group for each message. 
 

10.14.1 Requirements 
 

           An SMS capable cellular modem.    
           An Event is required to trigger each dial group.   See Events on page 38. 
 

10.14.2 Configuration 
 

Edit the SMS instrument by either double-clicking it, or right-clicking on it and selecting 
Edit from the menu.  The following window will appear: 
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- Name: This is the label for the dialog tab for each group. It also appears in the Event Output 
selection list. 

- Description: This is also shown in the Event Output selection list. 
- Latch Alarm: Tick to latch the alarm. Once latched, the alarm is always sent even if the alarm 

condition clears on the following scan. 
- Reset Delay: Only available when the Latch option is selected.   

 It is the number of seconds to wait before allowing a re-triggering of the alarm. 
- Dialout phone number list: This lists the telephone numbers the message will be sent to. 

 Adding: Click Add Number to add a number to the list. When adding a number you 
may also add a short bit of text about the number, such as a name. 

 Editing: Select the number in the list, and then click on it again (double-clicking 
won’t work).  After a short delay the number will become editable. 

 Deleting: Click Delete Number to remove the selected number from the list. 
 
 
 

- Dial group SMS message text: This is the message that will be sent to the listed   
     telephone numbers. There is no way to incorporate live readings or logged data into the  
     message. 

 
Along the bottom of the window are buttons for managing the dial out groups: 
 

-  Delete Group: This will delete the currently visible group.   
      It is not available when there is only one group defined. 
-  Copy Group: Click this to create a duplicate of the current group.   
      It will be given the name “Copy of Name”, where Name is the name of the current group. 
-  Add Group: Click this to create a new empty group.   
      It will be given the name “Dial Group #”, where # is a number equal to the number of  
      groups now defined. For example, if you have two groups defined and click this button, the  
      new group will be named “Dial Group 3”. 
 
 

10.14.3 Triggering a Dial Group 
 

To trigger a dial group so it sends its message to the listed numbers, it must be added as 
an Output of an Event. See Events on page 38 for a detailed description of how to create 
and manage events. 
When you have set up your events, make sure the event Output is set to the required 
SMS Alarm Dial Group: 
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10.15 T2L: Time Till Log 
 

The Time Till [Until] Log instrument provides a channel that contains the number of 
seconds until the next log interval. This is typically used to synchronize events around the 
log interval, for example, to switch a device on 30 seconds before the log interval to give it 
time to take a reading. 
 

10.15.1 Requirements 
 

           A scheme with a fixed logging interval.   
           This instrument will not work correctly with event-based schemes 

 

10.15.2 Configuration 
 

        

See page 65 for details on the Generic 
Instrument Setup Window  
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10.16 WINDOW: Window Controller 
 

The Window Controller instrument is a utility to let you switch an output on/off over several 
windows over the day e.g. for switching modem on for certain hours over the day. The 
Window instrument also requires the RELTIME instrument and will add this instrument to 
the scheme for you automatically. 
 
Note that the output from the logger may need a relay or similar device to provide 
sufficient power to switch the required load. 
 

10.16.1 Requirements 
 

Spare output channel. 
Additional switching (relay) for large loads. 
RELTIME Instrument (see RELTIME: Relative Time Channels on page 72). 

 
 

10.16.2 Configuration 
 

 
 

- Window Tab: Select the Window to edit. 
- Switch On Time: Enter the time to switch on the selected output in 24hr time format. 
- Switch Off Time: Enter the time to switch off the selected output in 24hr time format. 
- Use Output: Select the output to switch On/Off. 
- Enable Window: Select this to use the window in the scheme. Disabled windows are 

saved in the scheme so that you can easily re-enable them at a later date but are not 
included into the data logger program. 

- Add: Click Add to add a new window to the scheme. 
- Delete: Click on Delete to remove the selected window from the scheme. 
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11.0 APPENDIX A – COMMUNICATIONS VARIABLES 
 

Communications variables are used in the scheme settings. 
 

11.1 General Variables 
 
Variable Default Description 
DEFAULT -1 When a communications profile is marked as 

DEFAULT = -1 then this is the default communications 
method used to connect to the logger. 

FORCEPROMPT [RTS] Action to take to try to solicit a prompt from the logger. 
-[RTS] = toggle RTS 
-[nnn] = wait for time nnn in ms 
-[CR/LF] = send carriage/return character 

MAXTESTMODECHANNELGAP 30 To speed up communications, requests to logger 
memory addresses that are close to each other are 
consolidated into a single request.   How close they 
need to be is measured by the number of bytes 
specified in this setting. The default value is suitable 
for high-speed, low latency connections. For low-
speed, high latency connections (e.g. satellite), this 
value could be increased. 

PROMPTRETRIES 2 Number of times to wait for a prompt. 
PROMPTTIMEOUT 20 Time in seconds to wait for prompt. 
RECEIVEBLOCKSIZE 256 for NRT loggers 

1024 for other 
loggers 

The amount of bytes requested at a time from the 
logger. During unload this value is halved for each 
timeout to a minimum of 256 bytes. 

SENDBLOCKSIZE 256 The amount of bytes sent at a time to the logger 
TIMEOUT 5 Time in seconds to wait for any received 

communications. This timer is reset each time any new 
data arrives. 

TYPE RS232 The type of communications: 
- RS232 – Serial RS-232. 
- IP – Internet TCP/IP. 
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11.2 Type RS232 Specific Variables 
 
Variable Default Description 
AUTOBAUD -1 When set to -1 (true) on receipt of an unexpected character BAUDRATE is 

automatically changed to try to synchronise to the correct baud rate. 
Expected characters are 0-9, A-F * and <CR>. 

BAUDRATE 9600 RS232 serial port baud rate. 
COMMPORT 1 RS232 communications port number (1 to 16). 
METHOD DIRECT DIRECT = Connect direct to the RS232 serial port. 

PHONEMODEM = Connect via a phone modem on an RS232 serial port. 
OUTSIDELINE  Number to dial to reach an external line. Only prefixed to phone number if 

PHONENUMBER doesn’t start with OUTSIDELINE. 
PHONENUMBER  Number for phone modem to dial to connect to remote logger. 
RESET  String to send to modem to reset configuration. 
SETTINGS  Settings to configure modem. 
TELSWITCH  Telemetry switch number. 
TERMCHAR <CR/LF> Set the expected termination character from a phone modem. 

 

11.3 Type IP Specific Variables 
 
Variable Default Description 
ADDRESS  IP address of the remote site to connect to. 
METHOD UDP UDP = Connect over network using UDP protocol. 

TCP = Connect over network using TCP/IP protocol. 
GPRSPROXY = Connect over network routing through the NIWA 
GPRS proxy server for remote cellular access. 

PASSWORD  Password to access the NIWA GPRS proxy server. 
PORT  Port of the remote site to connect to. 
PROXYADDRESS  IP address of the NIWA GPRS proxy server. 
PROXYCONNECTRETRIES 15 Number of times to check for a connection to the NIWA GPRS proxy 

server. The connection is checked once per second. 
PROXYPORT  Port to connect to on the NIWA GPRS proxy server. 
USERNAME  Username to access the NIWA GPRS proxy server. 
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11.4 For NRT type loggers In the ENT buffer node 
 

Variable Default Description 

MEMORYOFFSET 4736 Magic offset to apply to the buffer control table registers to covert 
absolute address to logger virtual memory address. 

 
 
 
 
 
 
 
 
 
 
 
 
 

12.0 APPENDIX B – “SEND TO” CONTEXT MENU CONFIGURATION 
 
This appendix details how to configure the “Send To” context menu available when 
viewing Data files. 
 
Add a file named DATAPROC.XML to the StarlogV4 System directory  
(typically “C:\Program Files\StarlogV4\System”). 
 
An example will be used to add four menu items to the “Send To” context menu as per the 
picture below. 
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The DATAPROC.XML file must be edited to contain the following details.  
[An XML file is just a text file with a .XML extension rather than the conventional .TXT 
extension]. 
 
Tip: One way to create the XML file is to open a text file named DATAPROC.TXT in any 
text editor, modify the contents as required, save the file and then rename the file to 
DATAPROC.XML. Otherwise any XML Editor may be used.  Goggle is your friend. 
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<APPLICATIONS> 
 <APPLICATION> 
  <NAME>Notepad</NAME> 
  <KEY>NOTEPAD</KEY> 
  <PATH>C:\WINDOWS\NOTEPAD.EXE</PATH> 
  <COMMANDLINE>$(DATAFILE)</COMMANDLINE> 
 </APPLICATION> 
 <APPLICATION> 
  <NAME>Another Notepad</NAME> 
  <KEY>NOTEPAD</KEY> 
  <PATH>C:\WINDOWS\NOTEPAD.EXE</PATH> 
  <COMMANDLINE>$(DATAFILE)</COMMANDLINE> 
 </APPLICATION> 
 <APPLICATION> 
  <NAME>Copy to A: Drive</NAME> 
  <KEY>COPY</KEY> 
  <PATH>C:\copy_to_a_drive.bat</PATH> 
  <COMMANDLINE>"$(DATAFILE)"</COMMANDLINE> 
 </APPLICATION> 
 <APPLICATION> 
  <NAME>Copy to D: Drive</NAME> 
  <KEY>COPY</KEY> 
  <PATH>C:\copy_to_d_drive.bat</PATH> 
  <COMMANDLINE>"$(DATAFILE)"</COMMANDLINE> 
 </APPLICATION> 
</APPLICATIONS> 

 
Each <APPLICATION> node in the XML file describes one context menu item.   
The <NAME> node names the item in the “Send To” context menu. 
The <PATH> node tells StarlogV4 which program to call when the context menu item is 
clicked. 
The <COMMANDLINE> node tells StarlogV4 to pass the selected file to the configured 
program as the first parameter. 
$(DATAFILE)is the full path name to the selected DATA.CSV file. 
The “$(DATAFILE)” entry is double quoted when calling batch files so that directory paths 
containing space characters are passed as one item to the called batch file. 
 
The batch file “C:\copy_to_d_drive.bat” in the example above contains the following text. 
 
echo off 
copy %1 d:\ 
 
 
 
 
 
 
 
 
 
 
 
 

13.0 GLOSSARY 
 

Term Definition 
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Term Definition 

CDT Configuration Data Table.   A set of configuration values inside the logger. 

Channel An input that has been given an identifier and is able to be read and logged by the scheme 
program 

Dump file Originally the same as an unload file. Now more often refers to a file that contains an image of 
the loggers internal memory, used by Unidata engineers to provide technical support in some 
cases 

Event A calculation that results in a true/false answer.   Based on that answer, other actions can be 
performed, such as switching a relay, or logging data 

FTU Originally Field Test Unit – a handheld device used to test the operation of data loggers in the 
field.   Now used to refer to test displays on the PC that show the status of running schemes. 

Input An input into a logger. Typical inputs are analogue (voltage), digital (counter pulses, on/off 
states and data such as SDI-12) 

Load “Load a scheme” – the programming of a data logger with a scheme program. 

Log When the logger records data into its memory (buffer).Typically, this occurs at a fixed interval 
controlled by the scheme program, but can also be triggered by events to occurs at arbitrary 
times. The time between the fixed logging intervals is called the log interval. 

Log start Data loggers without internal sensors (excluding the internal battery and temperature sensors) 
reserve one pin on their input connector to detect when an instrument has been connected 
before starting to log, and to stop logging when the instrument is disconnected. 

Logger An electronic device that keeps a record of data.   In the context of the Starlog system, this 
includes many instruments with a built-in logger (such as the 6526 Starflow and 6541 Water 
Level Instrument) as well as dedicated standalone loggers such as the Starlogger and 
ProLogger. 

NMM Neon Metering Module.  In general, the range of Neon loggers housed in plastic enclosures 

NRT Neon Remote Terminal.  In general, the range of Neon loggers housed in metal enclosures 

Output The actions taken as the result of an event. As well as typical outputs such a signal sent to 
control a relay, outputs can also be entirely software in nature, such as forcing some data to 
be recorded. 

Prescale The dividing down of counter inputs to ensure a counter value will not exceed its maximum 
value before being read. Prescaling allows for a greater range, but at the cost of reduced 
resolution. 

Prescan A brief period of time before the logger scan where the logger is able to switch on its power 
supplies to instruments and allow them to stabilize before the scan wakes up the logger to 
take readings. 

Scan When the logger “wakes up” to read (scan) all of its inputs and perform the instructions 
specified by the scheme program. A scan always occurs at a fixed interval specified by the 
scheme program at the time of programming. Once programmed, the scan rate can only be 
changed by reprogramming the logger with a scheme.   Between scans, the logger is asleep 
and not performing any processing or monitoring any of its inputs, with the exception of the 
counter channels. 

The scan can be likened to the ticking of a clock; everything the logger does occurs on each 
tick. The time between scans is referred to as the scan interval. 
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Term Definition 

Scheme The instructions programmed into the logger telling it what to log, when to log, and any other 
actions or processing that it is required to perform. 

SDI-12 A standard that allows many instruments to be connected to a data logger via a common 
connection. 

Sleep The time the logger spends between scans. When asleep the logger consumes almost no 
power and is only monitoring its counter channels. 

Sub-interval When logging a standard average, all the values read during each scan of the log interval are 
used in the calculation. A sub-interval alters that by using a subset of the most recently 
scanned values. For example, with a 1 hour log interval, a 1 minute scan interval and a 15 
minute sub-interval, only those values read in the 15 minutes before the log are used in the 
calculation of the average. The values read during the other 45 minutes are ignored. 

Unload “Unload a logger” – the transfer of logged data from the logger to outside storage, typically a 
PC, but potentially a handheld device, or an intermediate data server. 

Unload file A data file containing data unloaded from a data logger. 

 

 


